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Introduction

Welcome to Sunlite Suite 3! You are probably eager to get dive straight into the software so
we have made the first two chapters short and simple. The aim of the first chapter is to
prepare you for using the software. The second chapter explains the foundations of the
software. If you are completely new to Sunlite Suite or lighting programming, the first two
chapters should be enough to get you started.
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Before We Start

Checklist

Before starting, make sure you have all the required tools. You should have a package with:
e USB-DMX interface
e PC orlaptop computer running Microsoft Windows, 7, 8, and 10
e USB cable
o Download the latest Sunlite Suite 3 software from www.sunlitepro.com

Computer Requirements

A modern PC running Windows 7, 8, or 10

If using Windows N or KN editions, install Microsoft Media Feature Pack

A multi-core processor

A screen resolution of at least 1280x768 (a higher resolution of 1920x1080 or more
is recommended)

4GB RAM minimum.

The 3D visualizer requires a powerful graphics card with at least 1GB graphics
memory or more (2GB+ recommended)

What's new in Sunlite Suite 3?

This chapter is for Sunlite Suite 2 users and outlines some of the new features in Sunlite
Suite 3.

User interface

The user interface has been re-designed to make it easier to perform tasks more quickly and
some features have been relocated to make them more accessible.

e Theicons around the software have been updated so that they can be displayed
more clearly on higher resolution displays. Preset icons now follow a new color
scheme:

Orange for position effects

Blue for shutter effects

Green for Gobo effects

Pink for Prism effects

Red for Iris effects

Yellow for Dimmer effects

Purple for Zoom effects

e We have brought back the menu bar from Sunlite Suite 1 and have re-designed the
ribbon bar to save space and allow for the various features of the software to be
easily located. For example, features related to a page are available from the Page
menu.
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e Docked pages are now combined within the same view, sharing the same ribbon
bar. This allows for a cleaner user interface and easier window management when
dealing with a high number of pages. The pages are also color coded which gives a
clearer outline of the currently selected page.

e Within each page, higher zoom levels are now available making it easier for use with
a touchscreen. A full screen button is also available in the upper right corner of
several views.

e Each view contains a menu to the top right containing all functionality related to the
view. For example, to change the way a fixture is displayed in the 2D fixture view,
click the menu to the upper right of the Fixture view, or to create a new console, click
the menu to the upper right of the Console view.

e Several views now contain a bar to the upper right to zoom the contents of the
corresponding view.

e |tis now possible to view more than one console at a time, side by side, and also
undock console views.

e Live control functions have been moved from the Group view and into two new Live
Actions view (whereby actions on the page are only applied to the selected fixtures,
with the selection being temporarily saved within the Live action), and Fixture
selection edits (whereby the fixture selection of the button is modified, with the new
selection being temporarily saved inside the button).
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New Cycle Editor

e FEasy Show software has been removed in Sunlite Suite 3, and all the functionality
has been integrated into the Cycle view. This allows for multiple audio/video



timelines to be easily integrated within the project without the need to set up
triggering between 2 different pieces of software.
There are now 2 types of timeline available:
o The timeline of triggers (e.g. SCENE ON, SCENE OFF) as was included with
Suite 2
o The new block timeline which works in a similar way to Easy Show and
allows for the automation of Speed/Dimmer/Size/Phase
Drag and drop audio blocks directly onto a Cycle timeline.
The Cycle can now analyse the BPM of an audio track allowing for Scenes and
Switches to be easily snapped to the beat.

£ Cycle - "Cycle" (Page "_MASTER")
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Programming Functions

The new FAN function allows for a set of values to be spread across a selection of
fixtures. For example, the beams of a selection of lights to be easily spread out into a
FAN formation. The FAN tool is available to the upper right of each Preset view
within the Editor and can also be applied to an Easy Time block by right clicking the
block.

A new switch priority called MLT (Multiply the current level) is now available. This
will multiply the % of all channels inside the switch by their current value. This allows
for Sub-Master dimmers to be created for any selection of fixtures instead of relying
only on the page dimmers.

A new virtual dimmer is now added to all fixtures without a dimmer channel. This
allows for dimming effects to be easily applied to color mixing fixtures. The virtual
dimmer is very powerful when combined with the Chaser and Curve effects, or when
used with the new MLT Switch mode.
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New Effects Engine

Sunlite Suite 3 features a brand new effects engine, allowing for a wider variety of color
mixing and Matrix effects to be applied to fixtures.

| Parameters
Effects list Rainbow

Cancel




The Sunlite Package

Here is a brief overview of all the software in the Sunlite package.

Sunlite Suite 3

This is the main piece of DMX lighting programming software. Quickly and easily program
complex effects with moving fixtures. Trigger with audio, MIDI, DMX, time and many other
methods. Copy scenes onto an SD card to play them without a computer.
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Easy View 2

Our real-time 3D visualiser allows you to pre-program your show without lighting fixtures.
This software will show you all of your lighting effects in the same way as they would look if
your actual lighting fixtures were connected to the computer. This software is not required
to program your show.




Scanlibrary Editor

Create your own profiles or modify existing profiles for lighting fixtures. Many effects are
included (colour, gobo, gobo rotation, prism, etc).
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Hardware Manager

An essential tool for configuring and testing your DMX interface. Perform many functions
including but not limited to updating the firmware, configuring settings and testing hardware.

Hardware Manager: Aug 10 2018 1.9.0-24222 SVMN:37123:37367M XHL:1.10.0-24222-5VN:37367-(Aug 10 2018) - O X

Connection  Firmware Diagnostic 7

~ =
Firmware:
Device Firmware Version 0.04
Device Firmware Compilation date 2018-07-13 15:04: 16
@ New Firmware Version 0.04
: New Firmware Compilation date 2018-07-13 15:04: 16
SIUDIDA Information
SiudilDA Firmware Update

Updating firmware, this may take a few minutes. DO NOT DISCONNECT YOUR DEVICE.
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Software and Hardware Installation

Installation

Download the latest Sunlite Suite 3 software from www.sunlitepro.com.

Follow the on-screen instructions to install the software. The DMX interface USB drivers will
be installed during the software installation. If a dialog appears to say “Do you want to allow

this app from an unknown publisher to make changes to your computer?” answer Yes.

User Account Control *

Do you want to allow this app from an
unknown publisher to make changes to your
device?

s
sun_suite3.exe

Publisher: Unknown
File origin: Hard drive on this computer

Show more details

Yes MNo

Once the software installation is complete, connect your interface to the USB socket. A
notification will be shown on the taskbar once the device has been setup with Windows. Do
not start the software until the driver installation is finished, otherwise your device will not
be detected.

1 Setting up a device

We're setting up 'SIUDITOA'.

Connect the Male (3/5 pins) end of the XLR cable into the Sunlite Suite 3 DMX interface and
connect the female (3/5 holes) end of the XLR into your first fixture.


http://www.sunlitepro.com/

Set the DMX address ID of each fixture on the DMX bus. Refer to your fixture

documentation to find out how to do this.

Fixture Profiles

Profile Editor

All of the attributes of a DMX device are saved in a special file called the “Fixture Profile” or
.SSL2 file. The more accurate the fixture profile, the easier it will be to program your lighting
with Sunlite Suite 3. If you have an incomplete fixture profile, Sunlite Suite 3 will not
understand the lights you want to control and therefore make it very difficult for you to
program your lighting fixtures.

There is a profile for almost every fixture on the market. Fixture profiles can be created and
edited with the "Scan Library" editor software.
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Quick Start

Main Sunlite Suite 3 Concepts

The main concepts of Sunlite Suite 3 are Pages, Scenes and Switches.

1. Each fixture type has its own Page.

2. Each page contains Scenes and Switchs.

3. A Scene controls multiple channel types. E.g. Colour AND gobo AND xy. Only one Scene
can be activated on a Page at one time.

4. A Switch controls one channel type. E.g. color OR gobo OR xy. It is possible to have as
many Switches activated as you like (as long as they don't affect the same channel type).
For example, you could have a Scene whereby the lights are moving and dimming up and
down. You can then make a "red wash" Switch and when the Switch is activated, the
moving Scene will carry on, but the lights turn red. Switches are good for quick temporary
changes and Scenes are where you would typically store your main lighting programming.

Creating Your First Show

Open Sunlite Suite 3. The open the show dialog can be found from the Controller menu.

Controller | Page Button View Lang

@ Open/Save show ] e

| 8 Protections evel | Consolg
|

rl a’ Controller

Controller settings
Print setup...

E—' Quit

Click here to create a new show.
Open Show
Show on hard drive
: i\lame Infos

IDen’m Show Current loaded ... Friday, October 13, 2017, 10:05




Step 1

Select your fixture from the left. Fixtures are ordered by manufacturer. In the example above
we are creating a page for a Moving Head which can be found in the "Generic" folder.

ew page with Scanlibrary d (Step 1-6)

Step 2

The software needs to know how many fixtures are being used and the starting DMX
address. In the example below we have 8 moving heads starting at address 1. You can also
access the Scanlibrary Editor from this patch window. The button to the left of the
Scanlibrary button allows you temporarily stop DMX output from all other pages for testing
purposes. The last icon to the left opens the Easy View 2 software.

ew page with Scanlibr; d (Step 2-6)

DMX universe 1

1 MOVING HEAD 18 19 MOVING HEAD
e b e T 5 a7 MOVING HEAD 54 55 MOVING H
icon to the DMX patch
27 MOVING HEAD o0

Fixture

Numb

< Back Cancel

Step 3

Using the grid on the right hand side you can limit the pan/tilt values of a selection of
fixtures. For example, if you are using a moving head in the corner of a room, you can set the
area so that the beam is not pointing at the back wall.



In some applications, you may have to set a limit to the highest Pan/Tilt amplitude being used.

Do you wish to limit the highest Pa t amplitude fo

Name S s the light .. InvP.. InvTilt SwapXandY | e

|MOVING H..

1ole

program all th

Step 4

The software will now create pre-programmed Switches for many of the common presets of
the fixture.

ith Scanlibr (Step 4-6)

You can choose to create pre-programme es from pres ned in the fixture-library.

Dim
D

limmer-solo

Cancel

Step b

The software can also create a variety of pre-programmed effects.



kN ew page with Scanlibra d (Step 5-6)

lect the relevant pre-programmed scenes and adjust the moving-area for the fixtures.

ircle phasing

ercle dephase de 5

Cancel

Step 6

You have now created your first page. The views can be rearranged by dragging and
dropping. Easy View 2 can be opened by clicking ‘Other Windows’ to see what has been
generated.

* ¥
vorites | Other windows |
| Palette
Stand Alone Editor
Easy View (3D} k

Auto start

ScanlLibrary




Creating Your First Scene

Notice that all of your pre-programmed buttons have a title shown in red. This means that
the button is a Switch button. A Switch button usually controls just one property. For
example here are 9 gobo switches. (These are compressed together to save space.)

A new Scene can be created here.

When "As you see now" is selected, everything you see from currently active Switches will
be saved into the Scene.

_MASTER
el S

C P Crama
Enter the name of the button scene

Choose hov would like the new burtton :

MName

. MOVING HEAD - VDimmer Dimmer
B MOVING HEAD - PositionEight

VING HEAD
VINGHEAD-INIT

OK + Edit Cancel




You can find more options for scenes using the button settings menu. Shift + right click on a
button and select Button settings.

Duplicate
Rename

Delete

Butron settings k

Edit

Show faders : Dimmer
Show faders : Speed
Show faders : Phasing
Show faders : Siz

Link to console

Link te keyboard

Button Settings window.

Button Settings... " Scene "

General General

a General lcon Name Text over icon

Trigger

Show faders
Speed

Force this function to work on all channels.

unction to wor n S

Undefined

| Disable "reset switch" when double click on this button.

Reset other buttons when activated

Cancel

Double clicking a Scene or Switch will deactivate all other buttons.



Editing a Scene with EasyStep
Step 1 Turn on the Light Beam

Scenes and Switches can be edited using the EasyStep tool or the EasyTime tool. In this
chapter, we will create a simple movement using the EasyStep tool. Click the beam open
icon to automatically activate the shutter, iris and dimmer channels. Create a new Scene,
make sure “As you see now” is selected and select “OK+Edit”

ut...

* E

jvorites  Other windows

+ 1

X VOVING HEAD

0K+ Edi 0 " Cancel
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Step 2 Select Fixtures to edit

Select the fixtures you wish the control here(1). Presets can be modified here(2).

Fade Time Hold Time
00m00s00 00m01s00

| cotor

U
[
Color  jiy

. | Fixeures
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Step 3 Assign the EasyStep channel function to the relevant channels

Channel functions can be set here. All channels are set to Off by default. To make a simple
movement pattern, assign the EasyStep channel function to the pan and tilt channels. Drag
the EasyStep icon here and hold CTRL to select multiple channels.

| moving head
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Step 4 Adjust Fixtures

In addition to the preset tab, you can also adjust your fixtures using the faders tab. Move the
X and Y faders to position the fixtures. Make sure you have the Easy View 2 3D window
open to see the movement.

fi§ o
. | |moving head
[ B3
1 2 3 4 5 6 7 8 9 10: 1% 32 13 14 A5 16 17 18
@ O x ¥ pX  p¥ Cyan Mage Yello Iris  Zoon Dimr Color Gobo Rotl Shutt Goba RotG Prisn Prisn
2 rotat

. TR T TR T BT T

i & ' 157 81 o o0 147 0 0 127 0 127 o o O (1]

iz gbgh'g‘h’?'b%’/gh*f%/%/*f*f*f%x%}%*;%&%&
ol

£
%




Step 5 Create a new step and preview

Once the values have been adjusted click here (1) to create a new step. Move the Xand Y
faders to the second position. Set a fade time and/or hold time for each step by double
clicking on the step time (2) or by selecting the clock button. EasyStep sequences can be
previewed by clicking the preview button (3).

d |@*9 i 1

Hold Time
00m01s00
00m06=00 00m01s00




Editing a Scene with EasyTime

Step 1 Turn on the light beam

Click the open beam button(1) to automatically open the dimmer, iris and shutter. Create a
new scene (2), make sure “As you see now”(3) is selected and select “OK + Edit” (4).

New Scene

2 MOVING HEAD
1 1 3 18

Enter the name of the button -

Choose button layer Other
would like the new button :
Empty

Equalta INIT

1
b Q.

Show the light beam J Shutter closed | Zoom Layout

Include the current
Include the activa
Name
2"~ Gobo Abstract1
n Iris IrisLinear
.Dimn‘uer Intensity
' Shutter Shutter open

#lZoom 2 4

oo ][k [ Gonee

Step 2 Select fixtures to edit

Select the fixtures you want to control from fixture view(1). Presets can be modified here(2)
in the preset view. Hidden views can be added from the toolbar at the top of the page(3).

Position 16 Bit
Unselect

Fixtures with pan and til Ay

Pan 130-100 | Btore

2 Tilt 129-236 1

Teaeeewe
b d




Step 3 Assign EasyTime function to channels

Assign the EasyTime channel function(1) to the channels you want to control. Drag the
EasyTime channel function here and hold CTRL to assign the function to multiple channels.
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Step 4 Drag an Effect to the timeline
Drag the pan/tilt effect
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Step 5 Editing your effect

Select “Curve”(1) from the Effect List. From this window you can change some aspects of
the effect. You can change the speed of the preview (2) and change the phasing (3). For
more information on the effects used with EasyTime see the EasyTime Effects chapter.

Speed preview

042 | 170 | |063 || 2!
” ” a

Phasing

Speed preview

Using a Midi Controller

Midi Controller

Almost all software features can be mapped to a MIDI controller. For example, dimmers can
be controlled by faders, Scenes can be triggered by buttons and commands such as 'BPM
Tap', 'Fixture selection' and 'Live record' can be mapped.

To map a MIDI console, open the console window(1) and right click (2) in the console
window to choose which you want to add. If your console is not listed, this can be built with
the Console Builder application available from the 'Other Windows' in the View menu on the
ribbon bar.

2 o 1) & * ]
Fixtures | Cycle | DMX level | Console JFade Favorites Other windows

r_XTouch_compact

maote
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There are a range of consoles which are pre-mapped. These mappings are documented
within the appendix section towards the end of this manual. If a pre-mapped console is
available, a message box will appear when a console is added asking if you would like to
load the mappings.

To manually map the console yourself:
e shift+right click a scene/switch/cycle
e select 'Link to console'
e choose the command you would like to map
e move the corresponding fader/dial/button on the MIDI controller

CHONCE@NN( b  dx Q.

Speed Dimmer Speed Dimmer Phasing Size | Show thelight beam Shutter closed | Zoom

Duplicate
Rename
Delete

Button settings

Waitin,

2 Click on the co window

Select a button

For more information on controlling the software from MIDI/DMX/tablet/smartphone, see the
'External Control & Triggering' chapter.



Programming

The Master Page
What is the Master Page?

The Master page is a combination of all the other pages in your show. It allows you to create
Scenes, Switches and Cycles which contain programming for more than one fixture type.
The Master page is usually your main live view, where you will add your final programming.

Fire Lines

Purple Rain

Pulse and Sweep

Scene 2

Scene 1

All On

Programming the Master page

In the image below we have pages for some moving heads, par64 and RGB fixtures. By
default, pages are created already linked to the Master page. When enabled, this link is
displayed as a star next to the page name (see highlighted below) and it allows the fixtures
to be controlled from the Master page.

W MASTER
1 1 3




Buttons on the Master page are created in the same way as on any fixture page. If you
create a button and select the “As You See Now” option, all currently activated buttons in all
pages will be saved (as long as the page is attached to the Master page).

Scenes can be modified quickly without the need to go inside the button editor. To modify a
parameter, ctrl+right click and drag a Switch from a fixture page to the Master page button
you wish to modify and select “copy”. In the example below we are changing the moving
head gobo.

I 7 _MASTER

INIT

Blue Centre

I v _MASTER

INIT

Blue Centre

Duplicate or copy

Do you wa licate the button Tri 0 the content of Tri G side Blue Centre 7

‘ Duplicate Cancel

If you are making a show for somebody else to use, or if you are limited on screen space,
you can close and dock all other windows and have just the Master page enabled. See the
access privileges topic for more information.

— Demo Show

All On Fire Lines Sequ

S~ -
INIT () ) Sequence 2

Pulse and Sweep Purple Rain Sequence 1
© @

Ly Chapter 1

Chapter 2

Entrance

Main Show

Emergency




Cycles

What is a Cycle?

A Cycle is an ordered cue list of Scenes and Switches which can be played back sequentially
and synchronised with audio and video files. A Cycle can consist of the following elements:
A Scene

A Switch

Another Cycle

An audio file

A video file

Cycle elements can be viewed as:
e Alist
e Timeline trigger markers
e Timeline blocks.

Click here (1) to open the Cycle view and click here(2) to create a new Cycle.

Controller Page Button |V

D Fixtures

Zoom Layout MNew Scene  MNew Switch MNew Cycle

W _MASTER
1

Recording a Cycle

To record a Cycle; click record(1), select a combination of Scenes and Switches then click
record again when you are done. Additional button presses can be recorded whilst playing a
Cycle by selecting the play/record button(2). Scenes and Switches may also be added by
holding Ctrl+Right clicking and dragging onto the timeline.
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Navig
To edit

ating around the Cycle view
a Cycle button, hold ctrl and click on a Cycle. By default, the Cycle view is split into

two parts. The upper part displays blocks representing the start and end time of an element.
The lower part shows trigger markers. The trigger markers are useful if you wish to tell an
element to only start or stop. Trigger markers represent ‘one shot’ triggers and do not have
a duration or end time.

Dragging the horizontal bar allows you to increase the portion of the view used for
Cycle blocks or triggers (1).

The order of the timeline, trigger, and block areas can be changed here (2).

A list of Cycle elements can be viewed by clicking here(3)

A global preview of the Cycle timeline can be viewed by clicking here (4)

Cycle elements can be moved around the timeline by clicking and dragging

A Cycle can be triggered by Midi Time Code by clicking here(5) (See the Midi Time
Code chapter for more information)

A Cycle will play up to the end marker. To change the Cycle end time, drag the end
marker or click here(6) to enter an end time manually.

The two buttons here(7) allow for a timeline to be locked, and for blocks to be
snapped to objects closeby

Right click to the left of the timeline to change the color, rename, delete, or create a
new timeline. Syncro sets the timeline to the master for synchronisation purposes (8)
Click here(9) for advanced button settings
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Adding Audio and Video

Audio and video files can be added to a Cycle simply by dragging and dropping the file onto
the corresponding timeline. Once a file has been dropped, you will be asked if you wish to
analyse the waveform.. This is necessary to view an image of the waveform on the block.
You will also be asked if you wish to detect beats. Detecting beats allows for other blocks to
be snapped to the detected beats for quick and easy Audio/Lighting synchronisation.

ac [ B MoviNG HEAD : Dimmer 2

Waveform analysis :

EAD : Gobo LLoop L

B movin

Analyzing the waveform may take a few minutes. Do you want to start the scan?
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Navigating a Cycle

Once a Cycle is selected, it is played automatically. Several additional navigation options are
available on the toolbar:

1. Previous/Next : jumps the cursor to the previous or next element

2. Previous/Next pause element : jumps the cursor to the previous or next element
which is set to a pause element. Use the right click menu on any element or marker
to set the pause state. This is useful if you are controlling a pre-programmed show
and you want to manually skip through a list of elements (similar to the GO button
on a traditional lighting console).

3. Move next element to current time: this will move the position of the next element to
the position of the current cursor. This is useful if you have already recorded the
order in which the blocks occur, but need to re-adjust the timing of the blocks live.
Make a space by shifting all blocks to the end of the timeline, hit play, then hit this
button at each ‘cue point’ and the next block will be moved to the current time.
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Cycle Automation

The dimmer, speed, size and phasing of an Scene/Switch element, and the volume of an
Audio/Video element can be automated by adding points inside the timeline block. Click
here (1) to select which curve to view, then click the + button here (2) to add automation
points.
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Cycle Element Settings

The Cycle element settings allow you to determine what the element will do when it is
triggered within the cycle.
e Type of action: determines if the element is switched On, switched Off or has a live
modification applied such as speed/dimmer/size/phase
e Time: manually set the time at which the element is triggered. Pause cycle will pause
the Cycle when the cursor reaches the element. This is useful if you are controlling a
pre-programmed show and you want to manually skip through a list of elements
(similar to the GO button on a traditional lighting console)
Fade: modify the elements fade settings
Curve and data for dimmer, speed, size, phasing: allows you to change the Dimmer,
Speed, Size and Phasing properties of the element
e Live- Allows you to add and remove fixtures from the button

Curve and datas for dimmer, speed, size, phasing

Type of action

Cancel




Scene Fading

We can set fade times between scenes. This is useful if we want to fade between two static
positions, or fade the dimmer. The fade function must first be enabled on the master
channels. This can be done from the patch tab within the page settings.

Fade times can be added from the page toolbar at the top of the page. Here you can set the
time before fade in(1), time before fade out(2), the fade in(3), and fade out(4) times.
Whether to use the fade in or fade out is determined by the current DMX level of the fading
channel. The fade in is used if current value is lower than the value of the fading scene. The
fade out is used if the current DMX value is higher than that of the fading scene.

Scene 2

Fade times can also be added from the button settings menu under the scene option. You
can also choose to manually control the fading from the scene settings page.

To visualise the fade, open up the Fade view. A fade can be
paused (1), skipped to the beginning(2)/end(3) or controlled
manually(4) using the fader (if manual fade is enabled within
the scene settings). In the Fade view, the bar on the left(5)
represents the fade in and the bar on the right(6) shows the
fade out. The lines at the top of the Fade view show a
graphical representation of the fades for the corresponding
Scene.

Button Editor

Channels

Select ‘Edit’ from the "Button" menu to access the button editor. You can also ctrl+click the
button. To edit a fixture, select the fixtures you wish to edit from the Fixtures view. The
channels will appear in the channels window.
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Preset Tabs

The Preset tabs allow for quicker modification of presets. A color wheel allows you to
modify the color of a fixture and the X-Y grid allows you to change the selected fixtures
position. To use the preset tabs you must have the Dimmer, EasyStep or ON channel
function assigned.

If you are editing a button on the Master page and are working with multiple fixtures of
different types, the Preset window is able to understand common channels between the
fixtures. For example, if you are using a CMY moving head, and an LED RGB panel, you will
be able to modify the color of both fixtures with a single color wheel.

| cotor

Color mixing
Color /il

Fanning

A range a values can be applied across a selection of fixtures. For example a range of
position values can be applied across a selection of Moving Head lights to create a fan
effect, or a range of dimmer values may be applied across a selection of beams to create a
dimmer gradient effect. Click towards the upper right of a preset control (1) to open the
Fanning Options window, or right click an easy time block and select ‘Fanning’ (2).
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The fanning options window shows a horizontal line with the left point representing the
starting value of the selected preset, and the right point representing the ending value of the
preset. Drag the ends of the horizontal bar up and down to adjust these values.

By default, the operation mode is set to Mirror allowing for the end point to adjust to the
opposite value as the starting point. Disabling Mirror allows for these values to be set
manually. Right clicking the curve adds another point, allowing for additional values to be
added. Clicking Curve Mode will draw a curve between the points. Clicking ‘Order’ will open
the Fixture Order window allowing for the fan to be applied in a different fixture order.

A B | E

Mode curve | Clear | Order

Right click to add point on curve.

Intel(f

Using the Channel Window

The button editor allows you to modify DMX channels in a variety of different ways. Before
editing your Scene, it is important to make sure that each DMX channel is assigned to the
correct function. To assign a channel function, drag one of the icons from the left onto the
top of a channel. Hold ctrl to drag onto multiple channels at once.

Function types:
e Off: Deactivates the channel



On: Allows manual adjustment of the channel fader
Dimmer: Allows manual adjustment of the channel fader. The channel will fade
between the set value and O if the button dimmer dial is moved

e Dimmer Min-Max: Allows a minimum and maximum value to be set. The channel will
fade between the minimum and maximum values if the button dimmer dial is moved.
Select the "Min" checkbox at the bottom of the fader to set the minimum value
EasyTime: Allows the channel to be edited using the EasyTime tool
EasyStep Fade: Allows the channel to be edited using the EasyStep tool
EasyStep Cut: Allows the channel to be edited using the EasyStep tool but ignores
any fade commands. This is useful for a gobo or shutter channel

Other options:
e To jump to a particular function, right click here(1) and select the function.
e To jump to a particular preset (eg. gobo holes, color red, shutter closed ), right click
here(2) and select the preset.
e Double click the white number to manually type the DMX value or %
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EasyTime

Select the "All" tab (1) to see the channels of all your fixtures.

e You can number your fixtures by index, channel address or universe number by
clicking the menu (2) to the top right of the channels view
The top right menu also allows you to toggle between DMX value and % value (2)
Double click on one of the white numbers (3) to manually enter a DMX or % value
Tip: when using the All channels tab, docking the window at the bottom of the
button editor will allow you to see more DMX channel faders, giving a similar view as
the button editor in Sunlite Suite 1
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Dragging a fixture on top of another will copy all editor data including dimmer, EasyTime
and EasyStep.

Arranging Buttons

Buttons can be arranged in a variety of different ways. Ctrl+right click and drag a button to
manually change its position.
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Custom Layouts

Custom layouts can be created here (1).

All I Layouts I

Re-arrange the buttons by type Page settings 4

Layer Add button, page 3

| New

Rename
Delete

Layout settings

Click here to create a new zone for your layout, then simply drag your buttons into the
relevant zone. Click the settings button if you want to embed a color mixing wheel or XY

grid inside the zone.



Layout settings

Drag and drop a button from one list to other.

Buttons Zones

There are no items to show.

[#] Other

Color mixing

Color mixing

Compression

Common switches can be compressed into one button. For example all the gobo switches
are grouped into one switch button like the example shown below.

To create a compression, make sure the Scenes or Switches you want to compress are
named with a common prefix. In the example below we have 4 scenes which start with the
prefix “Effect”.

Compression

:Name Info Button type

There are no ite

Cancel

Several different compression types can be created.
e External window icon: a dialog pops up with the button icons
e External window list: a dialog pops up with a list of the buttons



External window color mixing list: a dialog pops up with a list of the buttons and a
color mixing wheel

External window color mixing icon: a dialog pops up with the buttons icons and a
color mixing wheel

External window X/Y list: a dialog pops up with a list of the buttons and an X/Y grid
External window X/Y icon: a dialog pops up with the buttons icons and an X/Y grid
Icon: the default compression type whereby the icons are embedded within a section
inside the page

Other options include:

One Switch is always on: a minimum of one Switch will always be activated inside
the compression

Only one Switch is on: only one single Switch can be activated at a time within the
compression

Sort by name: the Switches inside the compression will automatically be sorted into
alphabetical order

| Sort by name

Button Speed, Dimmer, Size, Phasing

The dimmer, speed, size and phasing of a button can be changed by shift+right clicking a
button and selecting "Show Faders:" from the menu, or by shift+clicking on the button and
selecting one of the dials.

Speed: Changes the speed of an EasyTime or EasyStep sequence

Dimmer: Fades any channels with the dimmer or dimmer min/max property
assigned. Dimmer and Color mixing channels are also adjusted unless they are set to
OFF

Phasing: Takes an EasyTime sequence and starts it at a later point in the sequence
for each fixture

Size: Takes a pan/tilt effect and changes the size



Dimmer Phase

Speed, Dimmer, Size and Phasing dials can also be accessed at the top of the fixture page.
Page dimmer and speed dials can be accessed to the left.

MOVING HEAD

Dimmer Speed Dimmer Phasing

Advanced Phasing

Shift+right click a Switch phasing dial to view the advanced phasing menu. Here we can
determine how the software will apply phasing a Switch.
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No Phasing

When no phasing is applied, the example sequence here fades from red to yellow.
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Linear Phasing

When phasing is added, the sequence starts at a later point for each fixture. As the phasing
dial is increased, the time between each of the fixtures starting points increases.
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Non-Linear Phasing

When linear phasing is applied, the difference between each of the fixtures starting time is
the same.

There are 4 different non-linear phasing types available. With non-linear phasing, the
difference between each of the fixtures starting times changes. The difference between
each of the fixtures starting time gets shorter. This can be used to great effect to produce a
sequence which looks like an object falling for example.

Cube root x can often be used to create wave and rippling effects.
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Delay the begining of sequences

Delayed Phasing

When "Delay the beginning of sequences" is selected, the phasing is linear, however
instead of changing the starting point of the sequence for each fixture, it holds the first step
of the sequence and adds a delay. This is very useful for creating color sweeps!

Note: "Looping" must be switched off (1) for this type of phasing to work because the last
frame of each timeline is frozen to compensate for the delay at the beginning.
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Switch Behaviour

Priority

Usually a Switch should control a single channel type, with Scenes being left to control a
combination of different channels. However, sometimes it's necessary to combine different
channels inside of a single Switch, or to activate several Switches which use the same
channels. By default, the value of a channel set inside a Switch overrides the existing value
of the channel. However this can be changed within the Button Settings window.



The following options are available :

Latest Takes Priority (LTP): the value will override the existing value. If all the
channels used in the Switch are the same as the channels used in other Switches,
the other Switches will be released.

Highest Takes Priority (HTP): if the value is higher than the existing value, it will be
sent. Otherwise, it will be ignored.

Add to the current level (ADD): the value will be added to the existing value.
Subtract from the current level (SUB): The value will be subtracted from the existing
value.

Always Take Priority (ATP): the value will always override the existing value, even if
it's changed afterwards by another Switch (unless the other Switch is also set to
ATP)

Lowest Takes Priority (LowTP): if the value is lower than the existing value, it will be
sent. Otherwise, it will be ignored.

Multiply the current level (MLT): the % of the value will be multiplied by the existing
value. This is useful for creating submaster dimmers.

The Auto Release option will release the Switch automatically if all channels are being used
by other Switches and the other switches are set to LTP.

Button Settings.. " Sweep "

Priority

LTP Latest Takes Priority.

=l
2 ® Auto release

Options

# This switch will be automatically released in case of a double click on &

MLT Multiply the current level

7| Fade on activate

[[] Fade on release

Cancel

Other Options

Several other options are available in the Switch Button Settings window to set Switch
triggering priority and fading options:

This switch will automatically be released in case of a double click on another one:
does what it says!




e The switch is always ON: the Switch will always remain on regardless of what else is
triggered or double clicked
e Limited time: the Switch will turn off after the specified period
o Disable trigger until Switch is on: This will stop a switch being re-triggered, if
it has 1) been activated by a Port Trigger and 2) has not yet been released by
the Limited Time setting. Useful to stop a switch being retriggered by an
external sensor or button while playing. You can set a Port trigger for a
button on the Button Settings > Trigger screen. See the section on ‘Interface
Ports’ for more information.
o Fade on activate: The values within the Switch will be gradually faded from
their currently set values over the specified period
o Start playing the sequence during the fade: if the Switch contains a dynamic
EasyStep or EasyTime sequence. The sequence will begin to play as soon as
the Switch is activated. If unchecked, the Scene will pause on the first frame
until the fade is complete.
e Fade on release: as above but when the switch is released



Live Control

Live Fixtures

When the automatically generated Scenes and Switches are selected, all the fixtures on the
page respond to the button presses. Using the Live Fixture view (located in the View Menu),
it is possible to have independent control of the fixtures without the need to edit the active
Scene or Switch.

- From the menu, open View > Live Actions (1)

- Click REC (2)

- Select the fixture(s) you wish to control in the Fixtures Window (3)

- Press Scenes and Switches buttons. These actions are recorded to only the selected
fixtures which will display a tick (3). The selected fixtures will continue to be
controlled by the Live view window even after recording has stopped.

Note: Pressing the AUTO button (2) makes the record button release after a Scene or
Switch has been pressed.

g Live actions

][ <]
Rec || | auTo

GE) Sgtter Strob

When fixtures are controlled live, you will see a list of edits. Fixtures can be added (4) or
removed (5) from the edit on the list. An edit can be removed using the “X” at the end of the
row. To remove all the edits, click the larger “X” at the top of the view (6).

You can think of Live Fixtures as a layer on top of the regular Scenes and Switches that that
only affect selected fixtures. With REC deselected, you can continue to control your other
fixtures without affecting the Live Fixture edits layered on top.



Fixtures Selection Edits

Using Fixture Selection Edits, it is possible to have independent control of the fixtures
without the need to edit the active Scene or Switch. The key difference from Live Fixtures is
that the edits are stored inside a Scene or Switch button. Whenever you select the Scene or
Switch button, only the selected fixtures will be affected.

- From the menu, open View > Fixture Selection Edits (1)

- Click REC (2)

- Select the fixture(s) you wish to control in the Fixtures Window (3)

- Press Scenes and Switches buttons (e.g. Gobo) (4). These actions are recorded to
only the selected fixtures and stored inside the button. You will see a warning
triangle appear to show that Fixture Selection Edits are active on the button.

Pages ao Fixture selection edits
@ Fixtures HT @
— AUTO

) Cycle —
2 Gobo 2 4BeamColor

il DMX level

;;ﬁ Console

" Live actions

00 Fixture selection edits ] |

> Fade

* Favorites
Main beams functions
Audio BFM
Other windows

Toolbar

Master

Note: If you open a Switch or Scene button in the button editor window you will not see any
changes to the channels from the Fixture Selection Editors.



Palettes

Palettes are very powerful when programming lighting. Imagine you are on a tour and you
get to a different venue and realize you need to move your drums 2 meters backwards, you
now have to change each of your Scenes. This can be time consuming! With Sunlite Suite 3,
we can set up Palettes. These can be useful if you need to update a set of Scenes at once.
The Palettes window is found under the Other windows Menu.

start Audio BFM
Close...
Auto start

'@‘ ScanLibrary

. Console editor

New Palettes can be created here. If you want to create a preset palette such as a gobo or a
color wheel color select “New Palette per fixture”. If you want to create a palette with a
variable preset such as pan/tilt, a color mixing color, a dimmer, iris or zoom preset you wiill
need to select “New Generic Palette Per Fixture”. See the next topic, Palette Types
(advanced), for more information.

kO B +]

New Delete Auto save tt Duplicate

J “  New generic palette ‘

w1  New generic palette per fixture

#® New paletre per fixture type

st New palette per fixture

W Prerecord palette

Use the global effects panel(1) to adjust your fixtures or right click and select a preset a
preset tab below(2) (not available when using Generic Palettes). Hold shift to assign the
same preset to all selected fixtures.
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New Palette groups can be created here.

New Delete Auto save

O

Per Fixture

Palettes can be applied to scenes within the button editor. Drag the palette onto the desired
channel and hold ctrl to select multiple channels. Palettes can also be dragged directly onto
a fixture, an EasyStep step or an EasyTime constant level block. For information on how to
use a palette inside a dynamic effect, see the advanced palettes topic.
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Palette Types (advanced)

The previous topic described how to create a palette and assign it to a scene. This topic will
explain the various palette types.

... Generic Palette
. Generic Palette Per Fi..
w

Palette per Fixture Type

3

Palette per fixture

Standard and Generic Palettes

There are two types of palettes, a Standard palette and a Generic palette.

The standard palette saves a DMX value, for example DMX value 251 on the gobo channel.
A generic palette saves the property of a preset, for example dimmer 50% or Zoom 20
degrees. Standard palettes are useful if you want to send the same DMX value to all
selected fixtures, or call a particular preset such as "Gobo Holes". Generic palettes are useful
if you need to save a variable length preset such as dimmer, iris , focus or zoom amongst
different types of fixtures. If the fixture profile has been set up correctly, this is very useful
for matching up properties between lighting fixtures. For example, imagine you have 2
moving heads with a different zoom range. You can quickly set the zoom to 20 degrees and
the software will translate this to the appropriate DMX value so that both the beams look
the same.



Generic Palette Example

Imagine we want to use some Martin Mac 700's and Mac 2000's. The range of their iris
sizes are different.

In this case, we create a generic palette with 50% value and the software will output
whatever DMX value is 50% of the iris size. The DMX value 100 will be sent to the Mac 700
and the value 107 will be sent to the Mac 2000.

Mac2000

Generic Palette Example 2

Imagine that you want to create some dimmer palettes. Dimmer palettes can be useful as
the light output can look different depending on the size of the venue and the other lights
you are using.

Let's say you want to set 75% intensity, however, some of your fixtures have inverted
dimmers. In this case you just need to create a generic palette for the dimmer and set the
intensity to 75%. It won't matter which brand of fixture you insert, what channel or range
the dimmer is, whether it is inverted or not. The software will send the corresponding DMX
value to make sure the brightness of the light is 75%.

Palette Per Fixture and Per Fixture Type

Standard palettes can be created per fixture or per fixture type. Palettes per fixture type can
be included inside EasyTime effects, however palettes per fixture cannot. This is because,
when an EasyTime effect is built it does not ask for information about each individual fixture,
it simply asks for the amount of fixtures and the individual properties of the fixture type.
From this, the effect is generated.



For example, let's say we want to use a color palette inside a rainbow effect. If we were to
take a palette per fixture, the color of each fixture could be different, so the effect would not
know which color to take to generate the rainbow.

Palettes per fixture type can also be useful in circumstances where the amount of fixtures
changes. Let's say we have 2 different fixture types with the same gobos but in a different
order. We could create a set of gobo palettes so we only have to click one button to access
the same gobo from both fixtures. If we had a palette per fixture, we would have to create
the palette for each individual fixture. If we added more fixtures at a later date, these would
then have to be updated. If we create the palette per fixture type, then we can add as many
fixtures as and when we want without the need to think about the palette!

Generic Palettes

Generic palettes are primarily used for colors. They can be applied to any fixture and also
any fixture type. For example, if you create a generic palette with the color "fire red" (picked
from the color wheel), this palette can be used on any CMY or RGB fixture to turn the color
"fire red". If you are creating a matrix effect on a Rect, you must use a generic palette. This
is because Rects can cross several fixture types, they only know how to create colors, they
know nothing about the properties or type of fixture it's being applied to. If you have a
palette per fixture type with 2 colors stored on 2 different types of fixture, the Rect would
not know which color to take to generate the effect.

Pre-Recorded Palettes

Pre-Recorded palettes are put together by the software depending on which fixtures you
are using.
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Followspot

What is a followspot?

A followspot is typically a powerful spotlight which lights up a performer on a stage. As the
performer moves around the stage, the spot will follow ensuring there is always a good light
coverage over the performer so that they stand out from everything else that's happening
on stage.

The problem with the followspot is that shadows are created around the performer and the
light is not always evenly dispersed around the performer. For example, when the performer
is at the side of the stage, the light may only cover one half of their body. The solution is to
use 2 or more followspots. Using multiple spots on the performer can look great, however
this requires multiple operators.

Using the XY grid, you can position a selection of lighting fixtures so that the beam points in
the same place, by holding ctl and moving one of the points, the others will follow relatively.
This works well in a small area, however the beams quickly become out of sync.

Setting up the Followspot

The followspot tool allows you to calibrate a set of points on the stage. Once the points
have been calibrated, all slave fixtures will perfectly follow the master feature.
To set up the followspot:
e Create a Switch (the followspot only works with Switches) and call it 'Followspot'
o Click 'OK and Edit' and open the followspot tool
e Drag the 'M' onto the master fixture and the 'S' onto the slave fixtures.
e Click record to begin calibrating the points
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Calibrating the Points

Move the master beam to the corner of the area you want to calibrate. This can be done
using the faders or the XY grid. Use the arrows on the keyboard to finely adjust the point.
You can change the mouse and keyboard precision by right clicking on the grid. It is best to
use a small iris size like in the example for an accurate calibration.

Once the master beam has been set, move the slave beams to the same point ensuring they
are all in the same quadrant of the XY grid as it's usually possible to set the same position
with 2 different XY values.




Click the + button to add a new calibration point, and move the master and slave fixtures to
the center top of the stage. A quick way to do this is to select all fixtures and hold ctl whilst
moving the point on the XY grid, this way all fixtures stay close and you can perfect the
calibration using the arrow keys.

The number of calibration points required depends on the positioning of the lighting fixtures
and the size of the area you want to cover. In the example below, there are 9 calibrated
points. Generally, the closer to the X axis you get, the more points you'll need to calibrate.

As you build your followspot, you'll notice a followspot area will be created. This highlighted
area shows where the lighting fixtures will be synchronized.

The followspot toolbar functions include:

e Record(1): When this button is pressed, all pan and tilt movements will be recorded.
If you want to test your followspot, release this button and move the master fixture

e Move area(2): when zoomed in, dragging in the followspot window will move the

visible area

Move point(3): dragging in the followspot window will move the point

Zoom in/out

Add point: adds a new calibration point

Remove point: removes a calibration point

Arrows: moves between each calibrated point

The 3rd button on the left(4) allows you to close the shutter of a lighting fixture when it's
positioned outside the calibrated area. To set this up:

e Drag and drop this icon onto the shutter channel

e Set the fader so that the shutter is open

e Click the 'min' checkbox at the bottom of the fader

e Set the fader so that the shutter is off
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Once the editor has been closed and saved, all slave fixtures will follow the master fixture as
long as the switch is activated. The switch works in 'Always take priority' mode to override
any pan/tilt values on slave fixtures.



EasyTime Effects

To use the EasyTime effects, first make sure that you have selected the relevant fixtures and
have assigned the EasyTime mode to the channels you want to control (1). To assign an
effect to your channels, drag it from the effects panel onto an empty space on the timeline
(2).
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Static

Static Effect
Static is the most basic effect. Depending on which type of channel you drag the effect onto,
a different set of options will be available.

If the static effect is dragged onto color mixing channels (e.g. rgb, rgbw, cmy) the color

wheel tools will appear on the left. If you have created a color Palette using the Palettes
window these will appear on the right.

Color mixing




Drag a static effect onto a pan/tilt channel of a moving fixture and you can modify the
position by dragging on the X/Y grid, or by choosing a palette if one has been created.

Edit EasyTime block

If an effect is dragged onto a gobo, color wheel, iris or dimmer channel, you can select from
one of the channel presets.

Gradient

Gradient Effect

The gradient effect works in the same way as the static effect, however it allows you fade
between DMX values (colors, positions..)

Start and end colors can be changed by selecting here (1). Colors can be added by double
clicking inside the gradient.



Phasing

Cancel

The gradient type can be changed:

-Auto gradient: Automatically fades between the blocks before and after the effect
-Linear(1): Fades between 2 points on the color wheel (there will be a dip in the brightness
as the marker passes through the center of the wheel)

-Shortest(2): Fades around the color wheel in the shortest direction

-Longest(3): Fades around the color wheel in the longest direction. This is useful when
creating rainbow effects all around the color wheel by setting the start and end colors as the
same.

Curve

Curve Effect
With the curves effect, basic mathematical formulas can be used to adjust a channel. In this
example, the red color level is being adjusted with a sinus wave.



:E| Parameters
Channel
Effects list

Channel

Cancel

Parameters:

- Channel : Select the red, blue or green channel for your curve effect. By activating curve
effects on multiple channels you can mix any color.

- Effects list: Different curve types can be selected here.

- Speed Preview: Adjust the speed of the preview shown in the area at the top.

- Rate : Change the frequency of the wave by adjusting the ratio. This will speed up your
pattern.

- Size : Used to stretch the wave, changing the amplitude.

- Phase : Move the wave backwards and forwards.

- Offset : Move the wave up or down

- Phasing : This parameter moves each fixture to a different point along the curve by giving
each a different phase. Remember that for phasing to work, you must have multiple fixtures
and the software must be told in which order your fixtures are positioned. For more
information on phasing, see the EasyTime Phasing topic.

Color

Color Effect

The color mixing effects tool does exactly this. It mixes colors together to create fantastic
looking effects very quickly.

- Select a color effect type(1)

- Change the parameters of the effect. (2) The parameters change depending on the effect
selected.

- To change the color, simply select the color and drag around the color wheel(3)

- To change the number of colors, use the + and - buttons (4)



:E| Parameters
E st

Color width

Angle

Gradient

Cancel

Pan Tilt

Pan Tilt effect

This effect is to be used on any pan or tilt channels of a fixture. It allows you to quickly and
easily create moving patterns.

-Click here (1) to switch the light beam on. This will not be saved as part of the effect but it
will allow you to see your fixtures as you adjust the position

-Select the shape you wish to create here(2)

-Alter the shape of the circle by dragging the points(3)

-Phasing can be added here(4)

-Set the centre point using a Palette (5)
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Chaser

Easy create chasers with this effect, giving the illusion of lights moving along a line.

Effect

|B Parameters
Effects list

Speed preview

B

o Click the light bulb (1) to switch the light beam on. This will not be saved as part of
the effect but it will allow you to see your fixtures as you adjust the position.
Select the chaser effect type (2) and parameters
Select and change the colors used by the effect (3)



Fixture Management

DMX Level

The DMX Level view displays the final DMX output for all the channels in your current show.
It is divided by universe on the top left(1). In addition to the DMX output, DMX input can be
viewed. The Show tab (2) displays the beam state of all the fixtures in the show. Tabs are
available along the top to filter the DMX output view for a selected page. The view can be
customised by clicking on Settings, available from the top left menu. From here you can
change the color, fonts, and which images are shown.

Fixtures

The Fixtures view allows for fixtures to be arranged and grouped for quick selection. It also
shows the real-time state of the color and gobo.

1. Fixtures can be moved by selecting the move tool (1) and then dragging.
2. There are 2 selection modes.
a. Select (2) : every new fixture clicked will be added to your existing selection.
Useful if using a tablet without a CTRL key.



b. Select with control key (3) : To select multiple fixtures you must hold down
the CTRL key while selecting. Without CTRL, your previous selection will be
deselected.

3. Fixture display options can be changed by clicking here (4).

4. Moving each fixture can be time consuming when using large amounts of fixtures.
Click here (5) to position your fixtures into a shape.

5. A different fixture view will appear depending on the selected page. To always show
the fixtures included on the master page regardless of the select page, click here (6).

Fixture Groups

Select the fixtures you wish to use in a group and then create a new group here. Right click
to edit, delete or rename.

LED Matrix

Back2

Rename

Group

Cancel




Background Image

To select a background for the Fixtures view, right click and select Background Picture.
Images can be imported or copied from the 3D visualiser. Use the fader to change the size
of the background image.

Rects

Using EasyTime, we can apply an effect to a selection of fixtures, or to a Rect. A Rectis a
virtual zone where a sequence can be played. You can for instance, play several sequences
on the same LED matrix at different positions using several Rects. Rects can be created on
the “Groups Rect” tab within the fixtures window of the button editor.

Groups rect

r cansolesele fixture function : 100

To apply an effect onto a Rect, drag the Rect into the timeline view to create a new timeline.
You can now drag your effects onto the timeline in the usual way.
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Groups rect

You can create as many rects as you wish. They can be resized and moved by selecting
Move (1, image below).
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Rect Layers

Additional layers can be added to a rect timeline by right clicking and selecting Add new
timeline. The opacity of a layer can be modified by right clicking the layer and selecting
opacity. In addition to changing the opacity a mask can be added to the area, for example
perhaps you would like all the black areas of a layer to be transparent. Use the fader on the
right to adjust the sensitivity of the transparency.



Note: The start of a timeline cannot be empty. This is why if you try to drag an effect along
the timeline, it will remain at the start. To create the effect of a blank area at the beginning
of your timeline you could use a static block with values set to black or off.

Color effect

Group rect Fixed level

Delete the timeline Color effect

Working channels

Advanced Patching

The software has many advanced patching capabilities. These can be found on the patch
tab with in the page settings window. The patch of a channel can be modified by clicking in
the patch area.

Page settings"MOVING HEAD"

General Fixtures

o General | Universe 1
Fixture D AG 1B onAMAARARAR

1234567890
@ Patch

E‘ 'j Group
0

Patch

4 - pY -0 presets

5- Cyan - 0 presets

10 - Dimmer - 3 presets

11 - Color - 10 presets

Click here to set up a new patch.



Dimmer % =

Channel Universe Minimum Maximum

There are no items t

Show in percent 0 Cancel

The output channel and universe can be set on the left and the minimum and maximum
amplitude can be set to scale channel values down. Setting the minimum to 255 and the
maximum to O will invert the channel. This can be useful when using unusual fixtures
whereby the dimmer is at 100% when the channel value is O.

Qurtput Amplitude
Address 10

DMX universe |1

Show in percent

0K Cancel

It is possible to limit the highest pan and tilt value of a fixture. This is useful if you have a
fixture in the corner of a room and you don't want the fixture to point at the wall. It can also
be used to calibrate a fixtures moving sequence if not programmed with palettes.
e The pan tilt dialog can be opened by clicking here(1)
e Select your fixtures, then adjust the size of the square on the right
e Use the target to move the fixtures around the room, notice a red line is drawn to
help you resize the square
You can view your fixtures graphically by deselecting "List View"
This dialog can also be an effective way to check if the lights are positioned correctly
within the fixtures window by checking the "Solo" radio button
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Managing DMX Interfaces and Universes

The software supports multiple universes and interfaces. The universes and interfaces can
be modified within the output tab of the Controller Settings. The software is set to
automatically select your interfaces by default. Uncheck auto detection to set this up
manually. Products can be selected here(1).

Some interfaces have more than one universe. Each universe in the software can be patched
to one of the interface outputs, or the DMX output universe can be swapped with a DMX
input universe (2) so the show can be triggered from a DMX desk. You can change the order
of your interfaces by dragging. You can delete an interface by dragging off the screen.

Note that extra Output Universes will not show in the Advanced menu list (3) unless you
have fixtures patched to each of these universes first. In the example below, there fixtures
patched to Universe 1,2 & 3 on one of the pages.
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ArtNet

If you have an Economy or First Class interface connected, you can output additional
universes from your computers Ethernet socket using a protocol which sends DMX over a
network. This protocol is called ArtNet.

Most of the time, your fixtures won't be able to read the ArtNet protocol and you will have to
convert it to DMX using an ArtNet to DMX converter. These can usually convert several
universes.

To set up ArtNet:

First, check our website to be sure the connected DMX interface contains an ArtNet licence.
If not, you can purchase a licence via the online http://store store.dmxsoft.com as long as
your interface is SUT compatible.

Initial Setup

1. Connect your DMX interface to your PC using a USB cable

2. Connect your computer to the same network as your Artnet Node(s). Consult your
Artnet Node documentation to find out how to do this.

3. Connect a DMX Tester or fixture to a DMX port your Artnet Node.



General

Aurto detection 2

o General Mo interface

Hardware

Configure Sunlite Suite 3

1.
2.
3.

Open Sunlite Suite 3 and navigate to Controller > Controller Settings in the menu
De-select ‘Auto detection’ (1 above)

Where it says ‘No interface’ (2 above), use the drop-down box to select your dmx
interface. For SUT compatible interfaces such as the Sunlite-BC, Sunlite-EC, etc
select ‘Smart DMX interface’ from the list.

A 2nd box with ‘No interface’ selected will appear below. Change this to to ‘Artnet’.
In the Artnet box, select the Universe number from Sunlite that you want to output
using the left drop down box (3 below).

Select which Node you want to send the Universe to on the right (4 below).
Repeat steps 5 & 6 for any additional universes and Artnet nodes you wish to
output.

Auto detection

General

&

General r z Smart DMX interface
DN Universe [output) 1
Hardware detection order

Advanced...
Auto detection

Hardware

L=

D& ] §

Artnet
Art-Met node Universe#1

Universe {output) 1 4 Art-Net node Universe#]
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e — ¥ Art-Met node Universe#2
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Printing a Patch

You can print a list of all the fixtures used in your show, their positions and DMX addresses.
This can be useful when setting DMX addresses on the fixtures and can also be sent to
clients or equipment hire companies.
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External Control & Triggering

Keyboard

Buttons can be triggered from the computer keyboard. To assign a keyboard trigger,
shift+right click a button and select Link to Keyboard.

Hit the key you wish to use as a trigger. Click here(1) to set the trigger as a Flash Trigger.
When you press the key, the button will be activated and when you release the key, the
button will be deactivated.

Link to keyboard

Press the keyboard key you wish to assign to
the button.

1

¥| Flash mode

Remove keyboard key Cancel

Date & Time

You can trigger a button by date and time. Select a button and open up the button settings.
Select the Time tab(1). There are 3 calendar views to choose from(2). Double click within the
calendar to set up a time trigger.

Scenes can be triggered at sunrise and sunset. A custom location can be assigned by
clicking here (1) and the time of sunrise and sunset will be automatically calculated. A
trigger time relative to the sunrise or sunset time can be assigned here(2). For example a
scene could be deactivated 4 hours after sunrise.



All day event

Start time: |07/08
Sunrise
Effective start date time : Wednesd
End time: |07/ = | 13:00:00

Daylight Mot used

Recurring events can be triggered daily, weekly, monthly or yearly. We can set up a
recurrence range between two dates. For example, you may want to trigger a button at
sunset every Saturday over the summer.

Appointment recurrence

F

20, 05h34m00

Duration:

Recur every

" Friday ¥ saturday Sunday
Yearly

No end date
End after 10 occurences

® End by

Cancel Remove recurrence

A trigger can be set to activate the button, deactivate the button, or toggle the button on
and off every time the trigger is called.

t the button on




Console (MIDI, DMX, EasyRemote, Joystick, VirtualDJ)

The console is a virtual screen consisting of faders, buttons, dials, color wheels, XY grids and
more. The console is a virtual gateway to allow Suite 3 to be controlled from a variety of
devices such as a MIDI controller, DMX controller, Joystick or smartphone/tablet running
EasyRemote. You can load a pre-made console or use the Console Editor to create an image
of your own controller. You can also design a customized layout to be used with a touch
screen or the EasyRemote iPhone/iPad/Android app. See the console editor topic for more
information on designing your own console.

EEE Console

‘ .

y

HEEE N

If you are using MIDI, the software first needs to be told which MIDI port to read from. This
can be set within the Controller Settings.

MIDI setup




To use the console with a DMX controller, make sure a DMX input universe has been
assigned within the interface settings.

Controller settings

General

General T [ SiT arface
DMX1 Univ tput) 1 e ot e
i Hardware detection order

! detection

Hardware DMX 3

i Output un No interface

Qutput unive

Input uni

Input ur

If you want to control the console from an iPhone, iPad or Android device:
Download the EasyRemote app from the Apple App Store or Google Play
Make sure the smartphone/tablet is connected to the same WiFi network as the
computer running Suite 3
Start the app
If the connection is successful and you have a console loaded in the software, you
will see Suite 3 appear in the menu
e FEasy Remote uses UDP port 4003. If you have a firewall be sure that this port is not
blocked




Mapping MIDI controls to the console

Right click here(1) to create a new console preset, and select your controller. If your
controller is not listed, you will need to build your own console with the console editor, or
map your controls to a similar console.

Akai ¥ Akai midimix
AXIOM 25 Akai MPD226
Behringer Akai MPK249
Behringer XTouch_compact

EasyRemote

Korg

M-Audio aka -8
Midicon APC mini
Movation apc20

ohm APC40
test123 APC40MKII
Traktor Kontrol F1

Vestax_spin

EasyRemote consoles are automatically mapped, however with a MIDI or DMX console you
will need to set up the mapping. Many of the pre-built consoles are mapped, however in
some circumstances you will need to map each button/dial/fader on your controller to the
console in the software:
1. Right click the button you want to link to your controller
2. Select the Console Setup tab(1)
3. Either enter the parameters in yourself or if you are using a MIDI controller, select
"Auto Setup MIDI"(2) and move the corresponding fader/dial/button on your MIDI
controller
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Each command and the corresponding fader can be viewed by clicking the menu button (1)
and then clicking settings(2). When all links are in view, the console can look confusing.
Select solo(3) to view the selected control only.
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Assigning commands

To assign a Suite 3 command to a button on the console:
1. Shift+Right click the desired scene
2. Select "Link to Console"
3. Select the desired action (activate the button, change the dimmer of the button etc..)
4. Select "Click on the Console Window" and select the relevant button inside the
console window. If you have a MIDI controller connected, move the relevant
fader/button on your controller.

Duplicate
Rename
Delete

Button settings

Link

Waiting for a MIDI

Click on the console window Cancel

One command on the controller can be used to activate a variety of different commands
within the software. For example, you could assign a dial to automatically control the speed
of several movement buttons. Right clicking on any button on the console will bring up the
console setup window where there are three tabs that allow you to assign a variety of
commands to the console. From any of the 3 tabs you can press the star button to access
the list of available commands for that tab.

e Live: the live tab allows you to control and assign many of the function for controlling
the software in a live setting. From selecting a page, activating a button and even
creating live and embedded fixtures.

e Edition: the edition tab gives you the option to control the effects and the editor from
your console.

e General: the general tab gives you control of pan/tilt functions as well as RGB/CMY
control. You can also create Virtual Selectors from the General tab which allow you
to control several different actions from one button depending on the currently active
Virtual Selector.
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Double clicking a command opens the command settings window. From this you can adjust
the minimum and maximum value of a slider or dial. Select linear(1) to control the level of
the relevant console button. In the example below when the console value reaches 53(2)
the corresponding channel will be at 100%.

or name and state _

I sctive level aned note Outeside acve l2vel and

.1 Poire offf

The trigger level option changes the value at which buttons will be triggered by a fader. The
next 2 columns control what happens when the console value is within the trigger range(3)
and outside of the trigger range(4). You can also move to the purple trigger area(5) along
the bar to change the actions of the console fader.
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To assign a color wheel or pan/tilt grid:
o Right click the color wheel or grid on the console

Click the 'General' tab

Click the star on the top right

Go to Others->'color mixing control command' or 'pan/tilt control command'

The color wheel or grid can be mapped to a button by selecting the page and button

name.

o Be sure that the dimmer property has been assigned to the appropriate channels
within the button editor.

General (1)

Command

Infos
m... Selected page - Selected button - Tri 4 5 & 7 8
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DMX

Controls within the software can be mapped to a DMX controller. You can use the Console
Editor to create an image of your own DMX controller. See the Console Editor topic for more
information. The controller can then be viewed within the console window.

Make sure you have DMX input setup within the Controller Settings, see the Managing DMX
Interfaces and Universes topic for more information. Once you have created your console,
each control must be mapped to a control on the console. To do this, right click on a console
control, then select the DMX input universe and channel.

MIDI ...... Control 3 - Preset 2

| Console setup

Proportional

[ Data
Midi data
[ DMX data

Universe

VirtualDJ datas
oystick
| Channel

group index

Close...

Once the DMX controller is mapped to the Console, you can map the controllers faders, dials
and buttons to almost any software feature. See the Console topic for more information.

Direct DMX Patch

A DMX input channel can also be directly assigned to a fixture channel within the button
editor. Click here(1) to open the DMX input panel, then drag the desired DMX input channel
over to the fixture channel.
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Joystick

You can control a pan and tilt grid with a Joystick. This is set up using the Console.

Create a console with an XY grid or load up an existing console such as '10 buttons,
color, Pan Tilt' or 'EasyRemote 2'

Pair the console with an XY zone or with a group of lighting fixtures (see the console
topic or more information)

Right click the grid and click the 'Console Setup' tab

The following options are available:

Pan: Set the Joystick options for the Pan property of the XY grid

Tilt: Set the Joystick options for the Tilt property of the XY grid

Enable: Allow the joystick to control the grid

Joystick index: If you have several joysticks created, you can choose which joystick to
use with the selected grid

Axe or rotation type: Choose which joystick property you want to use to control the
Pan or Tilt of the grid. The options listed here depend on the joystick connected.
Normally it's best to use the X movement for the Pan and the Y movement for the
Tilt

Button to activate function: A joystick button can be selected which must be held
down to activate the control

Direction button to activate function: If the joystick has a direction button, this can be
chosen to activate the control

Values: If a direction button is chosen to activate the control, choose which direction
the button must be set
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Interface Ports

Some DMX interfaces come with 8 dry contact ports at the rear.

Note: The hardware ports require a SUT licence to work on many DMX interfaces. To check
your licence, open HardwareManager tool, connect your interface and check the SUT screen.
If you see the line “DMX channels: Port Trigger:Activated” your interface has the licence
already. If not, you can purchase a licence for a small fee from store.dmxsoft.com. SUT
licences are not required for wall mounted DMX controllers.
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StandAlone
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@ Hardware Manager: Jul 30 2019 1.10.0-25211 SVM:40797M X¥HL:1.10.3-25211-5VMN:40797-(Jul 30 2019)

SUT:

Offline remaining uses:

47.28 [ 47.28 Days (1134:3% hour)

Licences:

Arcolis Android: ARCOLIS FULL [ Android [ For Life
Daslight DVC1: DVC1 FULL f Windows f For Life
Daslight DVC3: DVC3 FULL [ Windows [ For Life
Daslight DVC4: Daslight 4 FULL [ Windows [ For Life
Daslight DVC4: Daslight 4 FULL / MacOS / For Life
Easy Stand Alone 1: ESA FULL / Windows [ For Life
ESA 2: ESAZ FULL / Windows [ For Life

ESA 2: ESAZ FULL f MacOS [ For Life

DMX channels: Rdm: Activated

DMX channels: Stand Alone Channels 1024

DMX channels: OffLine Authorized Time: 4084750
DMX channels: Live mode Channels: 1024

DMX channels: Fort Trigger: Activated

DMX channels: Dmx In: Activated

Light Rider: Light Rider FULL /i0S [ For Life

Light Rider: Light Rider FULL [ Android / For Life
Lumidesk: Lumidesk Express [ Windows [ For Life
Lumidesk: Lumidesk FULL / Windows [ For Life

RDM Manager: ALL DAS - FULL f Windows [ For Life

This socket is an HE10 interface port socket. You can connect an 8-button touch pad to this

socket. This works by bridging each of the 8 trigger pins with the ground pin.

You can connect up to 255 buttons by combining the 8 ports in binary. For example, if ports
1, 2 and 3 are connected to the ground pin, this will trigger address 7. One way of
combining the ports from a dry contact switch would be to insert a diode between the
switch and the ports. A general purpose diode for small signals can be used such as the

1n4148.
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Once the port connections have been set up. They can be assigned to trigger a scene within
the scene settings Trigger tab. If you are addressing the ports in binary, be sure to select
Address 8 for example, instead of Port 8.

You can also set up a port trigger from the previous/next buttons mounted on the interface.
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Cancel

MIDI Time Code (MTC)

MIDI Time Code (MTC) is a type of MIDI message created for synchronization purposes. You
can use Midi Time Code to synchronize a Cycle with an external device such as a CD player,
3rd party video and sound software, or a SMPTE generator.



To use MIDI time code, you first need to make sure you have a MIDI interface connected to
your computer.

Go to the general settings and select the MIDI setup tab. Select the device you wish to
receive the Time Code from or send the Time Code to. In the example below, we have
selected a virtual midi port (provided by third party software) as the input. Virtual midi ports
provide an easy way to transfer midi data between software running on the same computer.
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Once you have your MIDI Time Code device connected, select the IN button to begin
receiving the Time Code signal. To send Time Code to another device whilst the Cycle is
playing, select the OUT button.
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Note : when the Midi In button is enabled on the Cycle window, pressing play will not cause
playback to start. The cycle window is listening for MTC data and will only begin playback
when this is received by the selected MIDI Device.

Audio

EasyTime and EasyStep sequences can be triggered by audio.

1. Click here to enable audio in an EasyStep sequence

2. Click here to enable audio in an EasyTime sequence
Notice that the timeline values change to music notes. These can be dragged to change
where the playhead will jump on each beat.
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Sound to light selection

To be able to trigger a scene with audio, you must first select the sound to light detection
mode. Click 'Other Windows' on the 'Controller' tab of the ribbon bar and select 'Sound to
light'.

The window presents 5 options:
o Manual: Choose a manual BPM (Beats Per Minute) from the combo box
e Tap: Tap out a BPM by pressing the tap button
o Audio Analysis: Calculates a BPM from an incoming audio signal
e BPM by Midi Clock: Detects a midi clock signal sent from high end DJ software and
DJ mixers. Note that you will need to select a midi device from the Controller
Settings first



e Virtual DJ: as custom synchronisation system used by the Virtual DJ software

BPM by Midi clock is usually the most accurate form of BPM detection because DJ software
will analyse the BPM from the audio file before it is played.
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Audio Analyzer

The Audio Analyzer is a tool which detects the Beats Per Minute (BPM) of a piece of music.
The input device can be selected from the selection box in the top left, and the analyzer will
manage the rest.
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Advanced Settings - Filters and Presets

To access the advanced settings, select the 'Options' checkbox. The following settings are
available:
e Presets: All settings can be saved into a preset. To save a preset, select 'Add'
e Name: Enter a name for the selected preset (the default presets cannot be renamed)
e BPM: Set the minimum and maximum BPM to be detected



Filter: Tell the Audio Analyzer to only analyze certain frequences. For example, to just
listen to the bass frequencies, add a low-pass filter of 150Hz or less

Always send beats: The Audio Analyzer will carry on sending the BPM, even when
the music stops.

The Audio Analyzer calculates the BPM by detecting peaks in the audio. The peak is
calculated by taking a small sample of the incoming audio signal (a few milliseconds),
calculating the average volume level and comparing this to the average volume level across
a larger sample (a few seconds). The sensibility determines how many times higher the
small sample level must be then the larger sample level to be marked as a peak. For
example, if the sensibility set to 2 and the average volume is 20%, then the incoming signal
must reach 40% to be marked as a peak. Decreasing the sensibility will allow for more
peaks to be detected and setting a higher sensibility will detect less peaks but will generally
be more reliable. Highly compressed music requires a lower sensibility.
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Advanced Settings - Durations

Average: Sets the length of the larger sample window to calculate the average
volume level.

BPM: How long to wait before outputting a different BPM.

Normalization: If the audio input is very quiet, the Audio Analyzer will turn up the
volume level after the amount of time set. For example, the default value is setto 5
seconds, therefore the volume level will be analyzed over a 5 second period. If the
highest level over this period is 50%, then the input level will be multiplied by 2
Normalization %: Sets the threshold for when to normalize. By default, this value is
set to 50%, so if the average volume is above 50% it will not be normalized.

Stop detection / %: If 'Always send beats' is not checked, the Audio Analyzer will
stop sending beats to the control software after the specified time when the volume
level is below the % specified. By default, if the volume drops below 4% for over 0.5



seconds, the Audio analyzer will stop sending beats. If there is a lot of noise on the
audio input, it is advisable to increase this level.

Durations

Average : 5 BPM : 5
[ ] 5top detection : s when volume level is below : %G

Pulse Detection

In addition to triggering a scene by the music BPM, you can also trigger with the pulse of
the music. Unlike BPM which provides a consistent beat, pulse detection allows you to jump
between steps each time a peak of an audio signal reaches a threshold (set automatically
inside the audio analyzer). Click here to activate pulse detection on an EasyStep sequence.
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Bargraph Detection

The Bargraph allows you to filter a band of audio and link this to an EasyTime timeline. This
allows you to create many interesting effects based on the level of audio within a
designated frequency band. To set this up:

Click the Bargraph tab

Set the Gain (signal level), Attack time (time taken to respond to an increasing audio
level), and Release time (time taken to respond to a decreasing audio level),
frequency and width



Add, remove and rename frequency bands by clicking the small white arrow at the

top of the band
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To assign a Bargraph band to an EasyTime timeline, click the egg timer checkbox to toggle
between Time and Bargraph mode and right click the checkbox to chose the frequency band

you would like the timeline to respond to.




Other Features

Access Privileges

Various parts of the software can be locked and password protected. The access privileges
can be set within the Protections tab of the Controller Settings. Click here(1) to set a new
password.
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Click the lock key to lock the selected functions. Notice that a lock icon appears next to each
locked function. To lock or unlock the show, select Controller > Protections from the menu,
then enter the password, if prompted.
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Forgotten Password?

The password is stored in the Global Show XML file. This can be located by navigating to
the Datalight folder in the software root directory, selecting your show folder and opening
the Global XML file.

Favorites

A favourite is like a macro. It allows you to save and recall a software state. The favourites
view can be opened here (1) and a new favourite can be created here (2).

£ ih
Cycle DMXlevel Console

Favourites can be modified by selecting the Edit tab. Favourites are organised by page. In
the example below, the red color preset (1) can be removed from the favourite by selecting
the X button. To update the state of a particular page, select the buttons you wish to include
within the favourite, then select Update the saved button states (2).
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Favourites can also store window positions, this can be done by selecting "Update Value"
on the "Send Windows Positioning" parameter.
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Multimedia

The software is capable of playing audio and video files (if encoded correctly). To insert an
audio or video file, select a button, open the button settings and select the Video tab.
Insert the media file here(1)

e Here(2), we can test our video, and adjust the start and end markers
e Switch between video and sound here(3), and loop your video here
e Drag here (4) to zoom in/out of the timeline
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If you wish to output the video out of a secondary monitor (1), this can be set up within the
Controller Settings on the Video screen. You can also set the video to playback in full screen
(2) and change the video engine (3). You may need to restart the software before some of
these settings are applied.
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Stand Alone Editor

You can save Scenes and Switches into the stand alone memory of your interface so they
can be played without a computer. It is advisable that you back up some of your Scenes into
the interface in case of a computer crash. The Stand Alone editor can be accessed here.

Important: This feature will only work with interfaces which have a removable SD card
for storage. For interfaces with internal flash memory you will need to use Easy Stand
Alone software.
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The memory of several interfaces can be written simultaneously, click here(1) to add an
interface.
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Some interfaces have areas that scenes can be loaded into. New areas can be created
here(1). Pages can be assigned to an area by clicking here(2). New stand-alone scenes can
be created here(3).
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Creating a Stand Alone Scene

A stand alone scene can contain a combination of SCENE and SWITCH buttons. Click
here(1) to insert a new button. Drag the scene from the scenes panel and onto one of the 99
scene spaces. Make sure the correct area is selected.

Color EffectsRainbow

O Shutter Shutter open

F DimmerFlash All

Once your stand-alone scene has been dragged onto the interface, other scene settings
such as looping and port triggering can be edited by selecting here(1).
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Some interfaces have an internal clock and calendar so the scenes can be triggered by date
and time. The date and time triggers can be assigned within the calendar tab (1). Select the
date (2) and the scene from the left (3) and drag it over to the calendar. Timing can be
modified by double clicking on a scene in the calendar.
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Note: the time triggers created within the button settings are not applied in stand-alone
mode. Once the stand alone scenes have been created and assigned, the memory can be
written here(1).

) 1

Write the interface's memory] Write the show on computer




Other Tools

Easy View 2

To start the 3D visualizer, select "Easy View (3D)".
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The window may appear on top of all other windows, to disable this feature, select view and
click here.

When opening Easy View 2 from the software you will be asked whether to import your
patched fixtures. Answering ‘yes’ will import them into the 3D environment.

?

[-]

To arrange your fixtures and import other objects, select Build view. To avoid losing your
work, make sure to save your Easy View 2 scene using File > Save As.

The fixtures in the 3D visualizer will automatically communicate with your fixtures in the
software.
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Console Editor

With the console editor, you can create a virtual screen to be controlled via a touchscreen or
an iPhone/iPad/Android device using the EasyRemote app. You can also use the console
editor to create a graphical representation of your MIDI or DMX controller with moving
faders, dials and buttons. These can then be linked to almost all software features. See the
Console topic for more information on loading and mapping a pre-made console.

The console editor can be opened from the External Windows menu.
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. Console editor

Organize windows in tabs

To add a component, select the component from the ribbon and click in

the desired place on the console. A list of available components will appear. Click 'Default' to
insert a component without a skin. Default components are best for EasyRemote consoles
because the component skin is stored within the smartphone/tablet app, therefore the load
times are much quicker.

Components can be moved by dragging, be sure that the lock option is disabled in the top
right of the ribbon. To re-size an object drag one of the 8 squares. Holding alt and dragging
will change the size of the component zone whilst maintaining the size of the component
image. Each component zone can contain an image and some text.

The properties of the selected component appear on the right. These include:
e Position
e Size



o Group: Components can be added to a 'Group' (or 'Bank'). A 'Group of buttons'
object can then be assigned to the group. This allows for different controls to be
mapped to the component depending on the selected group button.

e Zone Draw: Here you can set the size of the image, the control design used (.ccd
file), and the position and alignment of the image within the zone.

e Text properties. Each zone can contain an image and some text, here you can set the
default text, color, font and alignment within the zone.

e Button: Default button behavior can be set here such as 'Flash mode' (the button is
released when you release it with the mouse) and MIDI velocity information.

e Data: This is where MIDI and DMX mappings are made. For iPhone/iPad/Android
users, EasyRemote mappings are made automatically.
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We recommend that 'Default' component designs are used where possible because these
can easily be resized, colored, and can be sent over the network to a smartphone or tablet.
However in some circumstances it's useful to design a custom skin for a button, fader or

dial. The CCD designer can be used for building custom components.

To create a custom component:

1. Click the 'Control design' tab



2. Click the 'New' button on the ribbon bar, or the 'Edit' button to edit an existing CCD
file

3. Each CCD file can contain 1 of each component. The component type can be
selected from the ribbon bar

4. The component design appears at the top and a preview of the component appears
at the bottom

5. The properties can be adjusted on the right such as image, cursor position, cursor
image, dial angle...
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Once your console has been saved, it will appear within the console selection list. See the
'Console (MIDI, DMX, EasyRemote)' topic for more information on mapping a console and
assigning software commands.
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Scan Library Editor

Scan Library allows you to create your own fixture profile to use with the software.

Before creating your own fixture profile, check that it has not already been created by
another user, see the SSL forums by logging into your account at www.nicolaudie.com.

If you are editing a fixture that is already in use by the software, you will need to restart the
software before your changes take effect.

If you want to regenerate the pre programmed buttons after modifying a profile, you will
need to re-patch the fixtures. The path window can be accessed from the page settings
dialog.
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Appendix

Show Structure

Here is a diagram of a show structure. Notice that each button is saved as a separate file.
Therefore you only need to manually save what is made within the button editor, everything
else is saved automatically. This also makes it very easy to copy page folders and button
files between different shows.

Clicking the save button in the open/save show dialog will compress all these files into one

single show file allowing you to easily create a backup or use the show on a different
computer.

Datalight

Pre-mapped MIDI controllers

Elation MidiCon Pro

Left Section

The faders and buttons to the left are used to control to control the pages(1). Each of the 8
columns represents a page. 8 banks of pages can be selected using the up/down arrows
giving the possibility to control up to 64 pages. This is expandable to 128 if required by
mapping the remaining 8 spare pages.



Each column is mapped to the following:

-Right arrow: Select the next button in the page(2)
-Left arrow: Select the previous button in the page(3)
-Number: Select the page(4)

-Fader: Page dimmer(5)

Center Section

-Master fader: Controls the master dimmer of the entire show(1)

-BO: Opens and closes the beams of all lighting fixtures in the entire show(2)

-4x4 button matrix: Select an compression/effect type. Use the arrows to cycle through the
compressions on the selected page. The bottom right 'Other' button allows you to select
buttons which are not included in any compression/effect type

-5x4 button matrix: Currently unused except for the 'Enter' key which is used to play the
selected button. These can be mapped to favorite scenes/switches.(3)

-5x2 button matrix: These are mapped to software functions. Edit a button, close the button
editor, create a scene, create a switch, create a cycle, record a cycle, record a live edit, clear a
live edit, tap the BPM, sync the BPM(4)

Right Section

This area is used for choosing fixtures, scenes, switches and cycles on the selected page. 4
banks of 32 buttons are available. The bank can be changed using the up/down arrows
giving access to 128 buttons/fixtures/groups. This is expandable to 512 by mapping the
remaining 12 spare pages. The function of the 32 buttons depends on the selected mode
button to the left:

-Fixt: Selects fixtures

-Grp: Selects groups

-Sel: Selects buttons

-Btn: Plays buttons

Wheel Section

The wheels change the speed, phase, size and dimmer of the selected button. Pressing the
wheels will reset to the default value. If a color mix effect type is selected, the wheels will
control Red/Cyan, Green/Magenta, Blue/Yellow, Dimmer. If a pan/tilt effect type is selected,
the wheels will control Pan, Tilt, 16 bit Pan, 16 bit Tilt. The 2 arrows can be used to jump
between selected scene within the selected compression/effect type.



ELATION:

Elation MidiCon 2

Left Section(excluding S Buttons)

-Master fader: Controls the master dimmer of the entire show(1)

-BO: Opens and closes the beams of all lighting fixtures in the entire show(2)

-4x4 button matrix: Select an compression/effect type. Use the arrows to cycle through the
compressions on the selected page. The bottom right '?' button allows you to select buttons
which are not included in any compression/effect type(3)

-5x4 button matrix: Currently unused except for the 'Enter' key which is used to play the
selected button. These can be mapped to favorite scenes/switches.

-5x2 button matrix: These are mapped to software functions. Edit a button, close the button
editor, create a scene, create a switch, create a cycle, record a cycle, record a live edit, clear a
live edit, tap the BPM, sync the BPM

Center Section

-Master fader: Controls the master dimmer of the entire show
-BO: Opens and closes the beams of all lighting fixtures in the entire show

Right Section

This area is used for choosing fixtures, scenes, switches and cycles on the selected page. 1
bank of 32 buttons is available giving access to 32 buttons/fixtures/groups, this is
expandable to 512 by mapping the remaining 15 spare pages. The function of the 32
buttons depends on the selected mode. The mode can be changed using S buttons 1-6.
-S1 Fixt: Selects fixtures

-52 Grp: Selects groups

-S3 Sel: Selects buttons

-S4 Btn: Plays buttons

-S5 Rec: Record a live edit

-S6 Clear: Clear a live edit

-The 8 letter buttons (A-H) are used to select an effect/compression type.



Wheel Section

The wheels change the speed, phase, size and dimmer of the selected button. Pressing the
wheels will reset to the default value. If a color mix effect type is selected, the wheels will
control Red/Cyan, Green/Magenta, Blue/Yellow. If a pan/tilt effect type is selected, the
wheels will control Pan, Tilt, 16 bit Pan.

ELaTiON

Elation MIDICon

Left Section(1)

The faders and buttons to the left are used to control to control the pages. Each of the 8
columns represents a page. 8 banks of pages can be selected using the up/down arrows
giving the possibility to control up to 64 pages. This is expandable to 128 if required by

mapping the remaining 8 spare pages.

Each column is mapped to the following:

-Right arrow: Select the next button in the page
-Left arrow: Select the previous button in the page
-Number: Select the page

-Fader: Page dimmer

Center Section(2)

-Master fader: Controls the master dimmer of the entire show
-BO: Opens and closes the beams of all lighting fixtures in the entire show



Right Section(3)

This area is used for choosing fixtures, scenes, switches and cycles on the selected page. 4
banks of 32 buttons are available. The bank can be changed using the up/down arrows
giving access to 128 buttons/fixtures/groups. This is expandable to 512 by mapping the
remaining 12 spare pages. The function of the 32 buttons depends on the selected mode.
The mode can be changed using S buttons 1-4.

-S1 Fixt: Selects fixtures

-S2 Grp: Selects groups

-S3 Sel: Selects buttons

-S54 Btn: Plays buttons

-S5 Rec: Record a live edit

-56 Clear: Clear a live edit

-The 10 touch sensitive buttons are used to select an effect/compression type

Wheel Section(4)

The wheels change the dimmer, speed and phase of the selected button. Pressing the
wheels will reset to the default value. If a color mix effect type is selected, the wheels will
control Red/Cyan, Green/Magenta, Blue/Yellow. If a pan/tilt effect type is selected, the
wheels will control Pan, Tilt, 16 bit Pan.

Matrixz Mode

Dimmer
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Page Dimers Effect Type

Behringer BCF2000

The default mapping of the Behringer BCF2000 features 3 modes which can be selected
using the buttons at the bottom right of the console.(1)



Page: used to select and control pages

Button: used to select and control buttons

Fixture: used to make live edits. A live edit allows you to play a Scene or Switch on a
selection of fixtures as opposed to all fixtures within a page

Page Mode

In page mode, each of the 8 columns controls a page within e show.

-The encoder dial is used to select a button within a page. Press the encoder to play the
selected

-The top row of buttons marked “Play” are used to select a page

-The bottom row of buttons are user assignable as, and can be mapped to most software
functions

Button Mode

In button mode, each of the 8 columns is assigned to an effect type. The effect types are
written along the top of the console.

-The encoder dial is used to select a button within the effect type. Press the encoder to play
the selected button

-The top row of buttons marked 'Play' are used to play the selected button

-The bottom row of buttons are user assignable as with page mode

Fixture Mode

Fixture mode is used for creating live edits. This allows you to play a scene/switch on a
selection of fixture. To create a live edit:

-Press the fixture mode button

-Use the 2 rows of 8 buttons to select up to 16 fixtures

-Go to button mode and select and play a scene/switch

-A new live edit will be listed in the bottom right of the fixture window. To clear all live edits,
press the ‘Clear’ button in the bottom right of the console

Encoder groups

By default, the 8 encode dials are used to select buttons. The encoders can also be used to
control Speed, Phase and Size of the selected Scene/Switch by pressing the 4 encoder
Group buttons at the top right of the console
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